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  DUMPStat Overview 1  

What is DUMPStat?
Thinking ‘green’ is becoming a daily occurrence; however, 
despite our best efforts, the need for waste disposal continues to 
grow. Of primary concern is the impact of leakage from waste 
disposal facilities on groundwater. Thus, hazardous, municipal, 
and private waste disposal facilities are all required to follow a 
groundwater monitoring program.

Statistical methods have been, and continue to be, the basis for 
investigating potential environmental impact. Determining 
which statistical methods to use and performing hundreds, or 
perhaps thousands, of statistical comparisons required for each 
monitoring event can be daunting to say the least. It is important 
that an appropriate site-specific plan be developed for each 
facility which includes effective verification resampling plans, 
selection of constituents and appropriate statistical methods (e.g., 
parametric and nonparametric prediction limits, or control 
charts for intra-well comparisons) that detect contamination 
when it is present and do not falsely conclude that the site is 
contaminated.
DUMPStat is an easy-to-learn system for performing state-of-
the-art statistical analysis of groundwater monitoring data. Its 
methodology is based on Statistical Methods for Groundwater 
Monitoring, Gibbons (1994), Wiley. Its statistical procedures 
balance both false positive and false negative rates for the entire 
facility and offers complete consistency with USEPA Subtitle C 
and D regulations, and all USEPA guidance and ASTM D6312-
98 guidance. 

All statistical modules were 
written by Dr. Robert Gibbons.
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DUMPStat can manage data sets of any size, and it maintains the 
information in a site-specific database. When subsequent 
monitoring events occur, data are simply appended to the 
database and analyses can be performed at a click of your mouse.

DUMPStat can perform traditional inter-well (upgradient versus 
downgradient) comparisons; however, the upgradient wells 
must accurately characterize the natural spatial variability that is 
observed in the downgradient wells. As an alternative, if the site 
has not been impacted by the well, DUMPStat can perform 
intra-well comparisons. These are preferable as they eliminate 
the spatial component of variability; thus the uncertainty in 
measured concentrations is decreased making intra-well 
comparisons more sensitive to real releases. DUMPStat offers 
two forms of intra-well analyses; you may use either Shewhart-
CUSUM control charts or well-specific prediction limits.

Why use DUMPStat?
◗ Users need not understand the complexities of groundwa-

ter monitoring statistics in order to produce a statistically 
rigorous analysis of routine detection monitoring data.

◗ Both site-wide false positive (indicating contamination 
where there is none) and false negative (missing contamina-
tion when it is present) rates are optimally balanced at min-
imal levels.

◗ Site-wide false positive and false negative rates are directly 
computed via Monte Carlo simulation of 10,000 monitor-
ing events from the facility based on existing site-specific 
conditions. They are displayed on a simple-to-understand 
graphical Statistical Power Chart.

◗ DUMPStat also features distributional testing, treatment of 
nondetects, trend analysis, outlier detections, and automatic 
generation of prediction limits.

DUMPStat helps avoid costly site assessments due to common 
misapplication of statistical methods to groundwater monitoring 
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data. However, if your site should require corrective action, it is 
often necessary to compare samples from a potentially impacted 
well to a groundwater quality protection standard. DUMPStat’s 
assessment monitoring module performs these comparisons 
with tests of increasing and decreasing trend and comparison of 
the standard to the upper 95% normal confidence limit applied 
to the last 4-16 samples.
It is essential that you obtain the participation of your state 
regulating agency in the creation and approval of your plan, in 
order to ensure that you will meet the necessary requirements 
both in the statistical analyses performed and the various forms 
of reporting. To that end, we encourage you to use the 30-day 
trial program to determine if DUMPStat will meet your needs.

DUMPStat Analyses

Upgradient vs. Downgradient 

Prediction Limits

If you choose the Up vs. Down Prediction Limits button, 
DUMPStat will perform traditional upgradient versus 
downgradient comparisons using the current database. During 
analysis, DUMPStat will:
◗ Automatically screen for outliers
◗ Test distributional assumptions
◗ Compute detection frequency
◗ Select optimal form of prediction limit

Statistical Power

If you choose the Statistical Power (for Up vs. Down) button, 
DUMPStat will compute the statistical power for your site as a 
whole, based on upgradient versus downgradient comparisons. 
It is necessary to run the Up vs. Down Prediction Limits analysis 

Questions?
Call DSI toll-free at 
1-877-374-7744, 
or visit our website at 
www.DiscerningSystems.com

After the analysis is complete, 
the results are available in 
tabular, graphical and 
worksheet forms.
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first as this analysis creates the input file required for the 
statistical power. During analysis, DUMPStat will:
◗ Determine the site-wide false positive rate (i.e., the percent-

age of failures when the upgradient versus downgradient 
true mean difference equals zero).

◗ Determine the false negative rates for effect sizes ranging 
from 1 to 5 standard deviation units over the upgradient 
mean.

Intra-Well 

Control Charts

If you choose the Intra-Well Control Charts button, DUMPStat 
will compute intra-well comparisons by means of a combined 
Shewhart-CUSUM control chart using the current database. 
During analysis, DUMPStat will:
◗ Compute combined Shewhart-CUSUM control charts 

automatically screening for outliers.
◗ Detect historical trends (optional).
◗ Compute detection frequency.
◗ Determine whether the new sample represents a verifica-

tion of a previous exceedance.

Prediction Limits

As an alternative to the combined Shewhart-CUSUM Control 
Chart methodology, DUMPStat can compute intra-well 
prediction limits using the current database. To do so, choose 
the Intra-Well Prediction Limits button. During analysis, 
DUMPStat will:
◗ Automatically screen for outliers.
◗ Compute detection frequency.
◗ Detect historical trends (optional).
◗ Select optimal form of prediction limit.

After the analysis is complete, 
a line function derived from 
the six points is displayed on 
the statistical power chart.

After the analysis is complete, 
the results are available in 
tabular, graphical and 
worksheet forms.
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Statistical Power
If you choose the Statistical Power (for Intra-Well Control 
Charts or Prediction Limits) button, DUMPStat will compute 
the statistical power for your site based on either the intra-well 
control chart comparisons or the intra-well prediction limits 
analysis, respectively. During analysis, DUMPStat will:
◗ Determine the site-wide false positive rate (i.e., the percent-

age of failures when the background versus current true 
mean difference equals zero).

◗ Determine the false negative rates for effect sizes ranging 
from 1 to 5 standard deviation units over the background 
mean.

After the analysis is complete, a line function derived from the 
six points is displayed on the statistical power chart.

Sublist Analyses

DUMPStat offers additional intra-well analyses that are 
performed on specific combinations of sample points and 
constituents. Before running the analysis, you need to specify a 
sublist to DUMPStat; that is, group certain constituents with the 
appropriate sample point(s).

Time Series
If you choose the Time Series button, DUMPStat will generate 
a series of graphs plotting the results over time, from the records 
matching:
◗ Constituents specified in the Select Constituents item of 

the Constituents Menu. AND

◗ Sample points specified in the Select Intra-Well item of the 
Sample Points Menu.

You must run the appropriate 
Intra-Well analysis before 
running its corresponding 
statistical power analysis.

Time Series graphs will also 
display significant increasing 
and/or decreasing trends if 
you select the Identify Historic 
Trends checkbox in Statistical 
Options.
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Analytical Data Summary
If you choose the Analytical Data Summary button, DUMPStat 
will provide you with a series of tables based on the sample 
points, constituents and dates, you have selected. You can easily 
change how the table will be ordered by selecting Data Summary 
Layout from the Settings Menu. DUMPStat will show you a 
preview of the tables (displaying a sample of real data) and you 
can alter your column or row heading choices if you wish.

VOC Detections
If you choose the VOC Detections button, DUMPStat will 
generate a table showing all detections of selected volatile 
organic compounds in all selected wells in the current database. 
On the Constituents Menu, choose Select VOCs to select the 
compounds you wish to be shown in VOC Detections.

Confidence Limits (Assessment)
If you select the Confidence Limits (Assessment) button, 
DUMPStat will perform the analysis required when a site fails 
detection monitoring or is in corrective action.

During analysis, DUMPStat will:
◗ Compare hazardous constituents that are detected at the 

facility to state agency specific standards (concentration 
limits).

◗ Determine if the remediation efforts are making the situa-
tion better or worse by testing for increasing or decreasing 
trends in the measurements over time.

Surface Water or Air Monitoring
If you select either of these buttons, DUMPStat will compare 
paired (i.e., taken on the same day) upstream vs. downstream or 
upwind vs. downwind measurements using the nonparametric 
Wilcoxon test. In addition, upstream/downstream and upwind/
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downwind sample locations are tested for increasing trends 
using Sen’s test. Finally, upper confidence limits for the mean 
concentration at upstream/downstream or upwind/downwind 
sample locations are computed. These limits can be compared 
directly to regulatory standards if required.
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  Getting Started 2  

Hardware & Software Requirements
To run DUMPStat you must have certain hardware and software 
installed on your computer.
◗ An IBM®-compatible machine with a Pentium® processor 

or higher.
◗ A hard disk with at least 30 megabytes of available space. 

More may be required if your system does not already have 
Microsoft® database access components installed.

◗ A CD-ROM drive is recommended.
◗ Windows® 95, 98, NT 4.0, 2000, or XP.
◗ A mouse or other pointing device is recommended.
◗ A Windows-compatible printer is recommended.

Installation
DUMPStat is installed on your computer using the program 
INSTALL.EXE, from the CD-ROM; or DUMPWEB.EXE, 
from the Discerning Systems website. The install program 
installs DUMPStat itself, the statistical processing modules, the 
support files, and the online help system to your hard disk. 

Removing DUMPStat
If you wish to remove 
DUMPStat from your 
computer, use the Add/
Remove Programs item from 
Control Panel (found in the 
Settings option from the Start 
Menu).
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To download & install DUMPStat from the Discerning Systems 
website:

1. Click on the Download Demo link.
2. Fill out the download form and click on Submit. 
3. Save DUMPWEB.EXE to a directory on your hard drive. 
4. Shut down all running Windows applications.
5. From the Start Menu, choose Run.
6. Click on Browse and select DUMPWEB.EXE from the 

directory in which you’ve saved it. OR
Find DUMPWEB.EXE in Windows Explorer and simply 
double-click on it.

To install DUMPStat from the CD-ROM:

1. Shut down all Windows applications that are running.
2. Insert the CD in your CD-ROM drive (in this case we 

assume it to be Drive D).
3. From the Start Menu, choose Run.
4. Type d:\install and follow the instructions on the screen.

In addition to DUMPStat itself, the installation program can 
install:
◗ DUMPStat file converters. These programs, DUMPMate 

and GritConv, convert DUMPStat site files to a format 
readable by GRITS/STAT and vice versa. 

◗ Adobe® Acrobat® Reader. Acrobat Reader is required to 
view the User’s Guide PDF and, once you’ve registered, the 
Statistical Guide PDF. These are both accessible from 
DUMPStat’s Help Menu.

If you do not have Acrobat Reader installed on your computer, 
the box will be checked automatically. However, both of these 
components are optional, and you may proceed with both boxes 
unchecked if you wish.

Important
Windows requires that two 
additional components be 
available for DUMPStat work 
properly. If the installation 
program detects the absence 
of one or both of these 
components, it will install 
them for you. Simply follow 
the instructions provided on 
the screen during the 
installation process—and be 
patient! Do not reboot your 
computer until you are told to 
do so. Leave the CD-ROM in 
the drive while the system 
reboots, and if the installation 
program doesn’t continue on 
its own after the reboot, just 
start it again and it will pick up 
where it left off.
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Using DUMPStat

Starting the Program
To start DUMPStat, choose ‘DUMPStat’ from the DUMPStat 
Folder in the Programs Folder in the Start Menu.

Please keep in mind that this booklet merely outlines the basic 
information required to use DUMPStat. For more details, 
consult the online help system or the User’s Guide PDF. Both 
of these reference all aspects of DUMPStat, and can be accessed 
through the Help Menu. Within the Help Menu, you may search 
for specific topics with the Help Search tool or you may press F1 
to get context-sensitive help in DUMPStat or its viewers.

Help Contents
For information on Help topics choose Contents from the Help 
Menu or press F1 and click on the Contents button. You can use 
the Contents screen to jump to items in the DUMPStat menus.

Help Search
1. Click on the Search button from any Help topic window or 

choose Search for Help On from the Help Menu.
2. In the Search dialog box type a keyword or select one from 

the list by scrolling up or down. Press ENTER or click on 
Show Topics (or Display) to display a list of topics related 
to the word(s) you specified.

3. Select a topic name and then press ENTER or click on Go 
To (or Display) to view the topic.

Context-Sensitive Help (F1)
All the menu items, dialog screens and some of the entries on 
those screens contain context-sensitive help. Context-sensitive 
means you can get help on topics directly without having to go 

If you need help on a topic, 
but don’t know specifically 
what menu it falls under, you 
can find it by searching for its 
keywords.
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through the Help Menu. For example, if you want further 
information on an item listed in a menu, highlight the menu item 
and press F1. Information on that menu item will be displayed 
immediately. If you open Help topics in this manner you still 
have access to the Help functions listed above.

Loading the Demonstration Site
DUMPStat comes with a predefined demonstration site that 
allows you to become familiar with some of its features. A 
complete set of analyses has already been prepared for this site, 
and you may view the output by opening any of the companion 
viewers.

To load the demonstration site:

1. Click on Load Another Site from the Site Menu.
2. Click on Predefined Demo Data.
3. Click on OK.

You may now view the various settings for this site by accessing 
the different menu items. You may also view the analysis results 
that have been prepared for this site.

Viewing Output
DUMPStat comes with four related companion applications 
which allow you to view and print the results of statistical 
calculations. The Graph, Table, Worksheet, and Statistical 
Power Chart Viewers can be accessed through DUMPStat itself, 
or independently through the Windows desktop.
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Starting a viewer:

◗ Select the type of viewer from the Functions Menu of 
DUMPStat. OR

◗ Click on the viewer button on the DUMPStat toolbar. OR

◗ Click on the desired viewer in the DUMPStat Folder under 
Programs on the Start Menu (depending on your version of 
Windows). OR

◗ Double click on the viewer button beside an analysis on 
Perform Analyses to directly open the viewer with the 
results for that analysis.

The analyses’ results remain available for viewing even after you 
exit DUMPStat or a viewer. However, some operations in 
DUMPStat will result in your output being automatically cleared. 
Merging new data, editing your data or changing any of the 
statistical settings are examples of such operations.

Using a viewer:

◗ Selecting Open from the File Menu of any viewer allows 
you to choose which analysis result you want to view. You 
may have the results for several analyses open at a time in 
any viewer.

◗ The appearance of the output, both on screen and on your 
printer, can be controlled through options found in the File 
Menu of each viewer.

◗ Some analyses produce many pages of output. You can 
move through these pages either by using the scroll bars 
displayed on screen or by using items found on the Navi-
gate Menu.

◗ If you have opened multiple results within the same viewer, 
you can use items found on the Window Menu to display 
all the results.

◗ To close the active analysis results, select Close from the 
File Menu. This will not shut down the viewer itself.

◗ To shut down the viewer, select Exit from the File Menu.

Viewer buttons
 
Graph Viewer

Table Viewer

Worksheet Viewer

Power Chart Viewer

If one of the analyses listed is 
grayed out, then that 
particular analysis has not 
been run since your settings 
were altered.
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Graph Viewer
A graph is a pictorial representation of the concentration of a 
constituent over time, or as part of a group, which may be 
compared to a standard or limit. Also represented on the graph 
is the time period over which the background characteristics of 
the concentrations were determined if applicable. Exact values 
for points and lines on graphs can be found in the appropriate 
tables.

Table Viewer
A tabular analysis result may contain a single table or a series of 
tables which give detailed results based on statistical calculations 
and/or queries of the database. The rows of the table may be 
grouped by bands of color to indicate related items.

Worksheet Viewer
A worksheet is a series of calculations with accompanying 
explanations which describes which statistical methods were 
applied, which equations were used, and any constants or values 
‘looked up’. All intermediate calculations are shown so that you 
can follow along the process by which limits and other 
important values are determined.

Statistical Power Chart Viewer
A statistical power chart indicates the site-wide expected false 
positive and false negative rates for a facility. The false positive 
rate (i.e., for a comparison to background analysis the percentage 
of failures when the background versus onsite true mean 
difference equals zero) is the ‘power’ where the curve intersects 
the y-axis. The false negative rate indicates the chance of missing 
contamination at a single location for a single constituent, i.e. 
missing a needle in a haystack, for effect sizes ranging from 1 to 
5 standard deviation units from background. That is, if the 

You may choose to restrict the 
display and printing to 
‘interesting’ graphs (labeled 
Significant Differences). 
These include, but are not 
limited to, exceedances, 
verified exceedances, and 
trends in background.

Typically, an increase for a 
single constituent is 
accompanied by an increase 
in other constituents and/or 
locations making it easier to 
detect exceedances than 
would be expected from the 
values on the curve.
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concentration of a single constituent in a single location were to 
become elevated by two standard deviations above background 
how likely would you be to ‘miss it’. This is shown on the chart 
as 100% minus the ‘power’, where power represents the 
probability of detecting the contamination.

The error rates depend on the number of locations, constituents 
and background measurements, type of analysis, distributional 
form and detection frequency of the constituents, and the 
individual comparison false positive rate of the statistic being 
used. A desirable curve is one that starts low and rises quickly 
thus protecting human health and the environment while not 
unduly penalizing a facility.

Print Pre-Analyzed Output
You may print any analyses output which exists when you load 
the demonstration site. Analysis results that you create cannot be 
printed until you register the program. To restore the original 
output of the demonstration site, simply choose Restore Current 
Site from the Site Menu.
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 Test-Driving DUMPStat 3 
To try out DUMPStat with your own data, you should first clear 
the current data from the DUMPStat database and then add in 
(or merge) your own data. At any time, you may reinstate the 
original demonstration site settings by selecting Restore Current 
Site from the Site Menu, or by loading the Predefined Demo 
Data site again.

To clear the database:

1. Choose Clear Database from the Database Menu.
2. DUMPStat will ask for confirmation twice before proceed-

ing. At each prompt, click on Yes. 

Now you are ready to add your own data.

Adding Your Own Data
Initially, you must have an ASCII file of the site’s historical data. 
The structure, or data format, of this file is defined to 
DUMPStat, and then the file is merged into the database. Future 
samplings will be added to the database simply by merging each 
new ASCII file.

Included with the program are the files DEMO.DAT, PH.DAT, 
and SURFAIR.DAT, which are samples of a site’s historical data 
and have been used to create the demonstration database. These 
files have been prepared in fixed column format. This format 
has been defined to DUMPStat via the Merge Data item on the 
Database Menu.

To merge data files:

1. Choose Merge Data from the Database Menu.
2. Click on Select File to choose the file to merge. 
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3. Click on the name of your data file and click on OK to dis-
play the file.
The name of the selected file (including the path) is dis-
played in the Merge Data window. If the text exceeds the 
length of the field, you can scroll to the end of field using 
the arrow keys.

4. Look at the flow of your data to determine its format, and 
click on the appropriate radio button to set the segmenta-
tion style:
◗ delimited
◗ fixed columns

Delimited data

1. In a delimited data file each field in a record will be sepa-
rated from surrounding fields by the use of one unique 
character.
a. Find the delimiting character within the data.
b. Choose that character from the delimiter box, or type it 

in if it does not appear in the selection.
2. Make sure the column headers are ordered correctly. You 

may change the order one of two ways:
◗ By clicking and dragging the headers. OR
◗ By entering the correct sequence in the Format Details 

dialog.
3. Select the correct date format from the Date Format box. 
4. Choose the correct qualifier. 
5. Select Ignore ‘TBK’ Records if necessary.
6. Scroll through the syntax check column to search for error 

messages, and check those records that have been flagged. 
Most errors are self-explanatory, and can be easily fixed.

7. Click on Merge when you are satisfied with the format of 
your records. DUMPStat informs you of events as they 
occur during the merge; e.g., if any new constituents or sam-

If the file is not present in the 
scrollable list, try looking in 
other directories, or use the 
list box to show additional file 
types.

Syntax check
The syntax check column 
checks each record’s format.
◗��‘OK’ and ‘nondetect’ 

statuses appear in black.
◗��Error messages appear in 

red. These indicate a 
formatting problem in one or 
more of the data fields. 
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ple points are encountered, or if some records are invalid, 
etc. 

8. If any action is required following these events, i.e., setting 
aliases, enter unit equivalences, or reviewing leftover 
records, DUMPStat will prompt you accordingly.

9. When the merge process is complete, click on Close to 
leave the dialog box.

Fixed columns

1. Click on the black bar between the data window’s horizon-
tal scroll bars and drag it to the right. This allows more 
room to view all of the column headings.

2. The column headers can be moved to fit the corresponding 
columns by clicking in the heading area, holding, and drag-
ging.

3. The column borders can be moved to the left or right by 
clicking on top of them, holding, and dragging.
a. Starting on the leftmost column, scroll down to find 

the widest entry in that column. This is how wide that 
column must be.

b. Widen the column (that is, drag the column border) to 
accommodate this entry.

c. Repeat for the rest of the columns, working from left 
to right.

4. The Qualifier column should be as wide as possible.
◗ The qualifiers themselves can be quite short, and it may 

not be readily apparent that there are any qualifiers if 
the column is not wide enough to ‘catch’ them.

◗ Scroll through as much of the datafile as possible to 
look for any qualifiers, and adjust your columns 
accordingly.

◗ Choose the correct qualifier.
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5. Select the correct date format from the Date Format box. 
6. Select Ignore ‘TBK’ Records if necessary.
7. If you have adjusted your column widths correctly, all or 

most of the records should be labeled ‘OK’ in the syntax 
check column, with the nondetects and ignores indicated. 
Scroll through the syntax column to search for error mes-
sages. Generally, these should be correctable by adjusting 
the column widths. 

8. Click on Merge when you are satisfied with the format of 
your records. DUMPStat informs you of events as they 
occur during the merge; e.g., if any new constituents or sam-
ple points are encountered, or if some records are invalid, 
etc. 

9. If any action is required following these events, i.e., setting 
aliases, enter unit equivalences, or reviewing leftover 
records, DUMPStat will prompt you accordingly.

10. When the merge process is complete, click on Close to 
leave the dialog box.

The Database
The contents of the database can be viewed in two ways 
depending on your needs. Both allow you to choose the order in 
which records are shown and search for records based on either 
specific or general criteria. However, View Database shows 
(read-only) records individually while Edit Database provides a 
grid view of all records which can be edited as required.
Since Edit Database allows you to alter records, you cannot leave 
this dialog open on your desktop. You must complete your 
actions before moving on to other areas of DUMPStat.

Invalid records are saved to 
an automatically-named 
leftover records file.

However, if you wish to look at 
your records while using other 
dialogs, View Database can 
be left open. 
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View Database
To view or search the contents of the current database, select 
View Database from the Database Menu.

Using the data scroll control (labeled Lab Results) to view 
records:

◗ Click on the left or right inside arrow buttons to move 
backward or forward one record at a time.

◗ Click on the buttons at the extreme ends of the data scroll 
control to move directly to the first or last record.

◗ To change the order in which records are displayed use the 
list box to indicate which field should be the major key (i.e., 
sorted first). Then reset the middle and minor keys as 
required.

Searching for specific records:

◗ Enter the first few letters of the item you want search for in 
the Search Filter boxes. When entering dates, DUMPStat 
will provide a sample of what format the date should be 
entered in, e.g., mm-dd-yyyy

◗ Click on Update.

The records corresponding only to the search criteria will be 
selected by DUMPStat and can be viewed using the data scroll 
control.

Viewing all records after performing a search:

Click on Defaults. All records can now be viewed as before.
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Edit Database
To view or edit the contents of the current database, select Edit 
Database from the Database Menu. Note that the database 
editor cannot be minimized and left on the Windows Desktop. 
If you choose Edit Database, you must complete your editing 
actions before DUMPStat will allow you to move on.

Using the grid viewer:

◗ To change the order in which records (rows) are displayed 
use the list box to indicate which field should be the major 
key (i.e., sorted first). Then reset the middle and minor keys 
as required. The table is automatically reordered when 
changes are made to the ordering options.

◗ To change the order in which the elements (columns) are 
displayed, place the cursor over the element heading, 
depress the left mouse button, and drag the column to its 
new position.

◗ To change the width of a column, place the cursor any-
where on a vertical line on either side of the column. The 
cursor will become a double-sided arrow. Depress the left 
mouse button and drag the column boundary to its new 
width. If you make the column too small, it will ‘disappear’ 
from the grid. The column still exists, but you must exit 
and re-open the grid viewer to view it.

Using the editor:

◗ To find a specific record or area in the database enter the 
first few letters of the item you want search for. Pressing 
the Find button will take you to the first record which 
matches or exceeds any combination of constituent, well or 
date.

◗ To edit a record, including marking or un-marking a manual 
outlier, highlight the record and then click on Edit.

◗ To add a record, click on Add.

The database editor is 
displayed in tabular form. 
Element headings are 
displayed at the top of the 
table, and, horizontal and 
vertical scroll bars will appear 
as needed.

All changes to the column 
display of records are in effect 
only for that session of the 
grid viewer.
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◗ To delete a record, highlight the record and then click on 
Delete.

◗ To display the log of all changes made to the database, click 
on Log.

Data Export/Print
DUMPStat allows you to export data from the database for use 
with other programs or for conforming with electronic reporting 
regulations in some states. You may choose a subset by 
constituents, sample points, a date range, or any combination of 
these. The data are output in a fixed column width ASCII text 
format, which is easily read into most spreadsheets. You may 
also choose to print the selection of data in a format similar to 
the tabular output. Choose Print/Export Records from the 
Database Menu.

The Well Network
Before you begin running your analyses, you must define the 
parameters for each well network. These consist of the 
constituents you wish to analyze, the wells in which you will be 
analyzing the constituents, and the types of analyses you will be 
performing.

If you must run the same type of analysis with a different well 
network at the same site, save each network as a zone and restore 
it when necessary. See Save Zone As on the Site Menu.
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Constituents
In order to operate, DUMPStat needs to know which 
constituents you want to use in your analyses. Your selections 
will remain intact for that site until you choose to change them.
1. Choose Select Constituents from the Constituents Menu.
2. A constituent can be moved from the Available List to the 

Selected List by clicking on the constituent(s) in the Availa-
ble List and then clicking on Add.

3. A constituent can be moved from the Selected List to the 
Available List by the same method; click on the constitu-
ent(s) in the Selected List and then click on Remove.

4. When the Selected List is to your satisfaction, save the list 
by clicking on OK.
OR
If you have made changes to your Selected List and do not 
wish to save them, click on Cancel. A message will appear 
asking if you wish to save your changes. Click on No.

Assessment

The method of preparing for an assessment analysis differs 
slightly from that outlined above. DUMPStat needs to know 
which constituents are to be assessed and what standard to use 
for each constituent (as defined by your state or other regulatory 
agency).

The Assessment Constituent List reflects the status of the 
constituents as either unselected, selected with a standard, or 
selected without a standard. Selected constituents with no 
standard will have a red ‘X’ beside the constituent name. 
Selected constituents with a standard will have a green disc 
beside the constituent name.

We have provided an outline 
of the steps required to run 
intra-well or inter-well, 
comparisons. 
The same series of steps can 
be followed when you are 
choosing constituents for 
VOC Detections, Data 
Summary, Surface Water, and 
Air Monitoring. Simply select 
the appropriate item on the 
Constituents Menu.
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1. Choose Select for Assessment from the Constituents 
Menu.

2. A constituent can be selected for analysis by clicking on the 
desired constituent in the Constituents List and then click-
ing on Select.

3. A constituent can be deselected by the same method; click 
on the desired constituent in the Constituents List and then 
clicking on Deselect.
a. Define the standard for each selected constituent: 

Click on the constituent and then click in the Standard 
box.

b. Type the number, then press the ENTER key.
4. When all desired constituents have been selected, save the 

list by clicking on OK.
OR
If you have made changes to your list and do not wish to 
save them, click on Cancel. A message will appear asking if 
you wish to save your changes. Click on No.

Sample Points

Up vs. Down

If you wish to perform an upgradient vs. downgradient analysis, 
DUMPStat needs to know which sample points you want to use 
in your analysis and whether they reflect upgradient wells, 
downgradient wells, or both. Your selections will remain intact 
for that site until you choose to change them.

Unlike some of the other Available Lists, the items are not 
physically removed from the list once selected. Instead, the 
Available List reflects how a sample point has been defined by 
placing an indicator beside its name. A sample point name in the 
Available List is marked with the designation of [U] if it is 
included in the Upgradient Wells List, [D] for the Downgradient 
Wells List, [B] for both, or [ ] for neither.
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1. Choose Select Up & Down from the Sample Points Menu.
2. Move the desired sample points to the Upgradient Wells 

List or the Downgradient Wells List by clicking on the sam-
ple point(s) in the Available List and click on Add Up or 
Add Down respectively.

3. A sample point can be removed from either the Upgradient 
Wells List or the Downgradient Wells List by the same 
method: click on the sample point(s) in either list and click 
on Remove Up or Remove Dn respectively.

4. When the lists are defined to your satisfaction, save them 
by clicking on OK.
OR
If you have made changes to your lists and do not wish to 
save them, click on Cancel. A message will appear asking if 
you wish to save your changes. Click on No.

Intra-Well

If you wish to perform an intra-well analysis DUMPStat needs 
to know which sample points you want to use in your analysis. 
Your selections will remain intact for that site until you choose 
to change them. Choose Select Intra-Well from the Sample 
Points Menu.

Surface Water Pairs
In order to perform a Surface Water analysis, DUMPStat needs 
to know which sample point pairs are to be assessed. DUMPStat 
also needs to know which sample points are upstream and which 
are downstream.
1. Choose Select Pairs for Surface Water from the Sample 

Points Menu.
2. In the Available List, click on a sample point that is to be 

designated as an upstream or downstream point.

Pairs for air monitoring are 
selected in the same manner 
as for surface water. Choose 
Select Pairs for Air Monitoring 
from the Sample Points 
Menu. 
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3. The Set as Upstream and Set as Downstream buttons will 
no longer be grayed out. Click on the appropriate button to 
designate the sample point as upstream or downstream.

4. Repeat steps (2) and (3) to complete the pair.

To modify an existing pair:

1. Choose Select Pairs for Surface Water from the Sample 
Points Menu.

2. Select the pair you wish to modify in the box labeled 
Upstream points and Downstream points. A bar going 
across the box will highlight the selected pair.

3. Click on the (newly) desired point in the Available list. The 
Set as Upstream and Set as Downstream buttons will no 
longer be grayed out.

4. Click on either the Set as Upstream or Set as Downstream 
button. The sample point will be placed on the appropriate 
side of the highlighted bar. 

5. When you modify Set as Upstream, the highlighted bar will 
move to keep the Upstream points in proper sort order.

To remove a pair:

1. Choose Select Pairs for Surface Water from the Sample 
Points Menu.

2. Click on the pair you wish to remove from the Upstream/
Downstream points box. A bar going across the box will 
highlight the selected pair.

3. Click on Remove Current Pair. You can remove any pair, 
even an incomplete pair.

To save or ignore changes:

When the Selected List is to your satisfaction, save the list 
by clicking on OK.
OR

The Upstream/Downstream 
Points list is sorted by 
upstream points. If you 
modify an upstream point on 
this list, the list will be 
automatically resorted.
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If you have made changes to your Selected List and do not 
wish to save them, click on Cancel. A message will appear 
asking if you wish to save your changes. Click on No.

Set Time Windows
The time window has different meanings for different analyses.
◗ For Intra-Well comparisons, the time window is interpreted 

as the background time period—the time during which 
samples from the sample point are known to be contami-
nant free. Samples taken after the end of the background 
period are compared to those within the time window.

◗ For Up vs. Down comparisons, the time window is inde-
pendent of time windows for the individual sample points. 
It is applied simultaneously to all the upgradient data to 
determine which data to include in the pool of 'uncontami-
nated' comparison data. 

◗ For Assessment, the statistical calculations are based on 
samples taken from the start of the time window to the 
most current data. That is, trends are only calculated from 
the start of the time window to the end of the sampling.

◗ For Surface Water and Air Monitoring, the time window 
specifies the range of sampling dates that are used in the 
statistical analyses. Only samples taken between the start 
and the end of the time window are analyzed.

You can set the time window individually for each of the sample 
points, and have a separate window for the upgradient data. This 
allows intra-well and up vs. down well networks to co-exist. 
Furthermore, new sample points can be seamlessly incorporated 
into DUMPStat without disturbing settings for existing sample 
points.

You can choose to display pre-background data in your graphs 
should you wish to show samples excluded prior to background.
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To set time windows:

1. Choose Set Time Windows from the Sample Points Menu.
2. Select the well(s) you wish to set the background time for 

by clicking on one or more of the wells in the Time Periods 
for Sample Points box, or click on Select All. The last well 
selected will appear on the detailed time bar.

3. To change the time for all the wells without changing Up 
vs. Down, click on Select All and then click on Up vs. 
Down.

4. Enter the Start Window, End Window, and Start Display 
month and year.

5. Click on Update Selected Wells to apply the changes dis-
played on the detailed time bar to the selected/highlighted 
wells in the Time Periods for Sample Points box.

6. You may want to ignore all data sampled past a particular 
month; e.g., exclude the data from the most recent quarter. 
In this case click on the associated checkbox, and type in an 
appropriate date.

7. When the time windows are defined to your satisfaction, 
save them by clicking on OK.
OR
If you have made changes to any date settings and have not 
yet Updated Selected Wells, DUMPStat will ask if you wish 
to update the wells. If you do not want to save your 
changes, click on No.

Statistical Options
DUMPStat’s statistical options are found on the Settings Menu. 
You can alter these settings and rerun the analyses to see the 
effect of your changes. To illustrate the consequences of these 
options, there are some sample exercises to perform starting on 
page 37. Note that when you change the settings, DUMPStat 
will automatically erase all output. Thus, we recommend 

Alternatively, you can use your 
ENTER key to leave each date 
field. This will apply the default 
button (Update Select Wells), 
ensuring that you save your 
date changes.
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reloading the demonstration site and following the exercises in 
order, as we have ensured that analysis results are available for 
viewing as required.

Detailed statistical information is available in the DUMPStat 
Statistical Guide which is provided when the software and 
license are purchased. However, the most comprehensive source 
on the specific statistical methodologies used and related 
statistical issues is Gibbons (1994) Statistical Methods for 
Groundwater Monitoring, John Wiley and Sons, New York, (ISBN 
0-471-58707-9). To order, call John Wiley and Sons at (800) 225-
5945. The ASTM D6312-98 guidance is available from ASTM at 
(610) 832-9585, or at http://www.astm.org.

Performing Analyses
With DUMPStat you can perform analyses in two ways, either 
individually or by running a group of analyses together. You can 
choose which analysis or analyses to run from the Perform 
Analysis item of the Functions Menu. Each analysis type is 
represented by a button. To run an individual analysis, simply 
double-click on that button.

To set up a series of analyses to run and automatically activate 
the output viewers upon completion:

1. Choose Perform Analyses from the Functions Menu.
2. Depress (click on) the buttons of the analyses you wish to 

run. All buttons can be depressed, even if the title appears 
grayed out. If the green dot •  appears, all the necessary 
steps have been taken to run that particular analysis (i.e., the 
well network defined, the setup options completed, etc.).

3. If the green dot does not appear on one of your selections, 
double-click on that button. DUMPStat will inform you 
why the analysis cannot be run at this time.

4. If you wish, choose the output you would like automatically 
displayed after the analyses are complete by selecting the 

A brief description of each 
analysis begins on page 29.
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desired output button to the right of each analysis button. 
Output choices include graphical, tabular, worksheets and 
statistical power charts.

5. In the Comprehensive frame, select As Marked to ensure 
that the output choices you have made are automatically 
shown upon completion of the analyses.

6. Select the ‘Do those with • ’ button. All possible selected 
analyses will be run in sequence. Thus, if a selected statisti-
cal power analysis was unavailable at the time of selection, 
when its preceding analysis is performed, the statistical 
power analysis becomes available and will be performed.
Example: The statistical power chart for Intra-Well Control Charts can 
and will only be created after the Intra-Well Control Charts analysis 
has been completed.

7. Click on Close or Cancel to leave the Perform Analyses dia-
log. Close will automatically save your selections for the 
next time; whereas Cancel will give you the options of sav-
ing your selections or not.

At any time, you may reinstate the original demonstration site 
settings by selecting Restore Current Site from the Site Menu, or 
by loading the Predefined Demo Data site again.

As the analyses are running, 
DUMPStat will show you 
which analysis in the 
sequence it is currently 
working on. If any event 
occurs that prevents an 
analysis from completing 
normally, the necessary status 
messages will be available for 
viewing upon completion of 
the sequence of analyses.
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  Practice Exercises 4  
Following are a few exercises that can be done with our sample 
database to illustrate some of DUMPStat’s features and 
capabilities.

We recommend that you follow these exercises in order, as we 
have ensured that analysis results are available for viewing as 
required.

Manual Outliers
The manual outlier feature allows you to identify data in the 
database that are known to be invalid because of sampling or 
other external conditions. Outliers that are identifiable by their 
large deviation from typical values are statistically detectable and 
are already automatically identified by DUMPStat. A data point 
should only (and always) be identified as an outlier manually if 
the reading is known to be invalid.

Exercise Choose Database > Edit Database.

Remember
When you alter any statistical 
settings in DUMPStat, all 
current output is erased. 
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If you scroll down the right-hand side to the Sulfate records, you 
will see that record for GW-11 on 04/24/90 has been flagged as 
being a manual outlier.

You can see a list of manual outliers by choosing View Manual 
Outliers on the Database Menu. You can see the effect on the 
analysis if you enable manual outliers in the Statistical Options 
dialog of the Settings Menu. For this data set, removing this 
background data point by making it an outlier changes the 
prediction limit algorithm from nonparametric to lognormal, 
which affects the up vs. down prediction limit enough to show 
that downgradient wells GW-24 and GW 26 are exceedances in 
sulfate.
1. With the manual outliers disabled (the default), use the 

Worksheet Viewer to make a note of the up vs. down pre-
diction limit for sulfate, and the method of computation of 
the limit.

2. Using the Table Viewer, see Table 2 to determine which 
wells and constituents are in exceedance and make note of 
them.

3. In the DUMPStat main window, choose Settings > Statisti-
cal Options and check the Enable Manual Outliers box. 
Then click on OK.

In the File Menu, enable both 
Display Footers and Display 
in Color to help find the 
exceedances.
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4. Rerun the Up vs. Down Prediction Limits analysis by dou-
ble clicking on that button on the Perform Analyses dialog 
of the Functions Menu.

5. Check the value for the prediction limit in the worksheet, 
and compare it to the value as noted in Step 1. Also review 
the wells and constituents that are now in exceedance in 
Table 2. Compare these to those noted in Step 2.

Running Multiple Analyses
In preparation for the next exercise, you must run two analyses 
to create output for viewing.

Exercise This is an opportunity to define a custom ‘batch’ analysis run 
and have DUMPStat perform all desired analyses and open the 
appropriate viewers automatically upon completion.
1. Choose Perform Analyses from the Functions Menu.

You can also use the Graph 
Viewer to quickly check for 
exceedances. After starting 
the viewer, enable the Display 
Significant Only option from 
the File Menu. 
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2. Make sure the Intra-Well Control Charts and Intra-Well 
Prediction Limits buttons are pushed in. The ‘go sign’ (the 
green disc • ) should appear on the button.

3. Since we don’t want to run any other analyses at this time, 
make sure that no other analyses buttons are selected 
(pushed in).

4. Make sure the graphical viewer output button is pushed in 
beside the Intra-Well Control Chart and Prediction Limit 
buttons. This means that these graphs will be automatically 
opened when the analysis is completed.

5. Make sure the other output buttons beside the Intra-Well 
buttons are not pushed in.

6. In the Comprehensive frame, click on As Marked to ensure 
that the output choices you have made are automatically 
shown upon completion of the analyses.

7. Click on the ‘Do those with • ’ button. The analyses will be 
run. DUMPStat will provide you with status messages dur-
ing and after the performing of the analyses.

Manual Reporting Limits
Reporting limit values are ignored for detect samples, but are 
used for nondetect samples. The value supplied is used in the 
calculation of the nonparametric or Poisson prediction limits; 
for example, when all of the background samples for a given 
constituent and well are all nondetects. If the data for a particular 
constituent have different reporting limits for different samples, 
as can happen if you get data from two different labs, then the 
difference in reporting limits can adversely effect the resulting 
nonparametric or Poisson prediction limits. Note that extreme 
reporting limits are also screened as outliers automatically by 
DUMPStat or can be excluded from statistical analyses by 
setting them as manual outliers.

If a ‘go’ sign does not appear, 
double-click that button. 
DUMPStat will tell you what 
steps need to be taken before 
that analysis can be 
performed.
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Exercise Using Edit Database from the Database Menu, you can see that 
the data for toluene has two different reporting limits, reflecting 
a change in analytical labs in February 1990. The previous lab 
had a reporting limit of 12 µg/l and the current lab reports 
6 µg/l. 

Using the Graph Viewer, look at the plot for toluene taken at 
GW-10 for either form of Intra-Well analysis. 

As you can see, a nonparametric limit is used, and the limit is set 
to the median reporting limit because all of the background data 
are nondetects. It is reasonable, however, to set a manual 
reporting limit in this case because there are enough data points 
from the new lab to establish the limit based on these data alone.
1. In DUMPStat, choose Set Manual Reporting Limits from 

the Constituents Menu. Note that toluene has a limit of 6 
µg/l, the value of the most recent lab data. However, until 
this setting is enabled it has no effect.

2. In the same dialog, click on the Enable Manual Reporting 
Limits check box. This will make all of the nondetect points 
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for toluene behave as though they all had a limit of 6 µg/l 
reported by the lab. Click on OK to exit the dialog.

3. Rerun the two Intra-Well analyses as you did on page 40.
4. Review the output. You will see that the control and predic-

tion limits for toluene have dropped, revealing an exceed-
ance for that constituent that was previously masked.

Sublist and Two-Sided Limits
DUMPStat allows you to pick and choose an arbitrary sublist of 
wells and constituents for intra-well analysis. Only one such 
sublist is defined for each zone in a site, but you could have 
multiple sublists for a site by having multiple zones. To create a 
sublist, you explicitly pick which sample points are to be 
monitored for each constituent. 

Exercise 1. Choose Define Sublist from either the Constituents or 
Sample Points Menu.

2. Confirm that for the demonstration site, there is only one 
constituent in the sublist—namely, pH. You can do this by 
highlighting each constituent and seeing if any associated 

Note
The same effect could have 
been achieved by limiting the 
background time window for 
the GW-10 sample point to 
only the 6 mg/l limit samples, 
but this would have affected 
all constituents at that well, 
not just toluene. Also, this 
would not have helped if the 
unwanted reporting limit was 
interspersed with the desired 
one in the background data.

These two unrelated features 
are normally used 
independently, but for the 
purposes of this exercise they 
are featured together.
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sample points are highlighted. Click on Cancel when you 
have finished.

3. Choose Select Constituents from the Constituents Menu. 
Note that pH is not included in the regular selected constit-
uent list. The sublist constituents may be chosen from any 
constituents in the database, and need not be included in 
any other analysis.
If you run the Intra-Well Sublist Control Charts or Predic-
tion Limits analyses, you will only see results for the con-
stituent well selections in the sublist.

Set Up for Multiple Analyses
Once again, in preparation for the remaining exercises, you must 
run three analyses to create output for viewing.

Exercise Set up DUMPStat to perform the only following analyses and 
have the specified output automatically displayed:
◗ Intra-Well Prediction Limits—graphs and worksheets
◗ Intra-Well Sublist Prediction Limits—graphs
◗ Analytical Data Summary—tables
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If you have any trouble setting this up, refer back to Running 
Multiple Analyses on page 39.

Two-sided Prediction Limits & pH
The pH measurement differs from concentration measurements 
in that there is a numerical maximum and minimum that a result 
must fall between to be considered acceptable. To account for 
this, the prediction limits (Up vs. Down and Intra-Well) treat the 
constituent pH differently from others and compute a two-sided 
limit. 

Exercise 1. In the Graph Viewer, look at the output for Intra-Well Sub-
list Prediction Limits. If necessary, use the Window Menu 
to find it.

2. There are two prediction limit lines for pH—an upper and 
lower. This is one of the few places where prediction limits 
are more useful than control charts—the CUSUM measure 
on the control chart only accounts for significant increases; 
however, the Shewhart portion of the control chart does 
account for the two sided nature of pH.

3. To see how the prediction limits are calculated, go to the 
Worksheet Viewer.
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Analytical Data Summary
This feature allows you to look at and print tables of your data 
sorted by constituent, date, or sample point. You can also 
restrict which constituents, sample points and dates you want to 
include in the summary. 
The analytical data summary also allows you to group together 
samples taken shortly after one another together as though they 
were taken on the same date. This would be necessary if you had 
a large site and it took several days to collect samples from all of 
your sample points. Normally you would be sampling different 
wells on each day as you worked through your site, but if the 
same well were sampled twice in the period of interest, 
DUMPStat will take the arithmetic mean of the values, and put 
a footnote in the summary showing that this was done.

Exercise The demonstration data set has an analytical data summary set 
up that shows all of the air and surface water readings for the 
entire site. 
1. Using the Table Viewer, look at the results for the Analyti-

cal Data Summary. If necessary, use the Window Menu to 
find it.

2. Use the bottom scroll bar to choose the last table, TOC. 
Use the upper scroll bar to move to the right of the table. 
You will see that the entries for SW-01 and SW-02 have 
asterisks beside them, indicating that they are averages.

You can decide what period of 
time you want to be 
considered the ‘same’ date. 
Choose Select Summary 
Dates from the Settings 
Menu.

Make sure that the footnotes 
are displayed and the display 
is in color. These options are 
set from the Table Viewer’s 
File Menu.
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3. Using Edit Database from the Database Menu, you can see 
that there are samples on successive days for TOC at sam-
ple points SW-01 and SW-02 at the end of January 1988.
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